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Features

In/Out board

Automatic “In” notification

Automatic “Out” notification

Customized remarks

Messaging system

Message notification

Employee Information screen

Available in four client sizes

Group feature

Search capability

Change others' status

Changing configurations

Features

Description

Receptionists can respond to visitors and callers without having to
search in the office to find out who is available. There’s no need to
guess when your co-worker on the other side of the floor is free.

When you turn on your computer, the display board automatically
indicates “In”.

You can choose the option to have the board indicate “Out” when you
turn off your computer.

In addition to the standard set of remarks, users can prepare their own
temporary or long-term customized remarks.

You can send and receive messages. Features include copy to
clipboard, clipboard paste, reply, and print. Messages cannot be viewed
by others.

When a message is received, a single chime will notify you that a
message is on your working screen (optional). If you do not want to
read it at that time, press on the space bar to minimize OfficeView. The
title bar will remind you that you have unread messages.

Each employee has his own information screen that only the employee
or the Administrator can update. It displays handy information for all to
read, such as - telephone, cell phone, fax and pager numbers, etc., and
a notepad with very large space. There is also a miscellaneous field
where you can record whatever information you chose, e.g., standard
hours of work, person to contact in your absence or home phone
number. A small message flag indicates if the employee has read his
mail.

The following user sizes are available: 10, 30, 300, and 1000.

The larger sizes of OfficeView (referred to as Group OfficeView) display
the names in groups/organizations. The 300 names size handles 12

groups of 30 names and the 1000 names version handles 34 groups of
30 names.

Group OfficeView has a feature that allows you to search for any names
in the organization. The user can start to type the name of an individual.
The program automatically scrolls you through the alphabetical listing to
the name, probably before you complete typing the name.

Nobody can change anybody else’s status unless the Administrator
gives the individual the capability to do so. This privilege is usually
given to receptionists and/or bosses.

Using a password, the Administrator can access and change important
information, such as adding or deleting users and groups and allowing
select users to change others’ status. This can be performed from any
workstation using the administrative password.



Available in four client sizes

Supports several platforms

Available in 16- and 32-bits

Easy installation

On-line database maintenance

Easy upgrades

Very efficient

On-line help

Free support

Free trial version

The following user sizes are available: 10, 30, 300 and 1000.

Self-contained native code for Windows 3.x, 95 and NT. Since there are
absolutely no DLL’s required, it won'’t interfere with the support files of
other applications.

These two versions can run harmoniously using the same database so
that any 32-bit operating systems can take maximum advantage of the
32-bit operating system capabilities.

Includes a Setup program with complete instructions to install it on your
LAN or server.

Administrators can update/maintain the database without having to shut
down the workstations.

You can upgrade from our web site without having to re-enter your
database of names and groups.

There is low band width consumption. It can run with as little as two
megs of hard disk space, including the space to store messages and
database information. Most offices with about 50 users would need
about three megs of disk space, including sufficient space to store
messages and the database.

Comprehensive on-line help is available. There is also the option to turn
on yellow hints that will guide you. We think this is a simple program
and if you need help, it won’t be for long.

Highly qualified staff give technical support to back up the product.
Check out our support web site or e-mail to OfficeView@Ottawa.com We
provide helpful and friendly advice.

For the latest version see http://www.capitalnet.com/~phillips/.



Easy Access to Hidden OfficeView Screen

If the application you are working in covers the OfficeView screen, you can quickly flip to it by holding
down the Alt key and tapping the Tab key until the OfficeView icon is selected. Release the Alt key to
pop up the OfficeView screen. Repeat the same procedure to return to your original application.



Password Access

A password system is available to control access to change some information. Specifically, this refers to
using the following commands: Add Name, Remove Name, My Name, Add New Group, Rename
Group, Delete Group, as well as changing information in other employees' Information windows.

Most users operate in User Mode which prevents them from accidentally adding or removing names, etc..
Administrative mode permits access to use all commands. To operate in Administrative Mode, the
Administrator(s) need only click on File/Admin Mode and enter the password. To disable Administrative
Mode, click on File/lUser Mode. The unregistered OfficeView defaults to Administrative Mode, permitting
you to easily explore all the features. The registered copy defaults to User Mode.

To change the password, click on File/Change Password and you will be prompted to enter the current
password once, and the new password twice. Passwords must consist of letters only. The program will
confirm that a new password has been accepted.

Initially, the security password is set to "abc". When you register you will be given an additional
emergency password.



Adding New Users

To add a new name to the display board, click on Add Name in the Options menu. Type the new name,
and choose OK or Enter. The names are automatically displayed alphabetically.

This command is password protected. See Administration.

Also see
Unrestricted Access to all commands



Associating a Name With a Workstation

The program must identify names with workstations in order to make the messaging system fully
functional.  To do this, select Admin Mode by clicking on File/Admin Mode. For each name, at the
appropriate workstation, click on the name to be associated with that workstation and select My Name

from the pop-up menu. The name will appear in the top title bar. This procedure need never be
repeated, unless a new user operates at that computer.



Removing Users

To remove a name, click on the name to be removed. From the pop-up menu which appears, click on
Remove Name and confirm the removal by choosing Yes.

Also see
Unrestricted Access to all commands



Signing In

To sign in, click in the remarks field beside your name and choose IN from the pop-up list. Your remarks
field will indicate IN and the background will change to a green colour.

If you want the program to automatically indicate IN beside your name when you turn on your computer,
then include the program in your Windows Startup group.

After signing in, if you do not wish to be disturbed, click on the remarks field beside your name and select
In But Unavailable from the pop-up list. This remark will appear beside your name and the background
will turn to purple.



Signing Out

To sign out, click on the remarks field adjacent to your name. A pop-up list will appear. Click on the
appropriate comment to assign it to the remarks field.

Some of the remarks contain “smart” fields which are identified inside {} or <> brackets. Remarks with
the word “time” in uppercase or lowercase inside {} brackets automatically insert the current time in the
remark. Prompts appear inside <> brackets. Prompts ask for information, such as a future date or time.

If the remark you want to insert is not available in the list, then you may enter a customized remark.
Click on <Custom Remark> and type your remark. <Custom Remark> is a temporary remark. If you
want to insert a permanent remark to the master list of remarks, use Add. Remarks on the list may also
be permanently added and deleted using the procedure outlined in Maintaining the List of Remarks.

Choosing a sign-out remark turns off the highlight in your remarks field.

If you choose Sign Out on Exit in the Options menu, then whenever you turn off your computer and your
remark is indicating IN, the remarks field will automatically change to OUT. The absence of a tick mark
in front of this item indicates that this feature is turned off. Clicking on Sign Out on Exit toggles this
feature on and off.



Changing User Remarks

To change a remark, use the same procedure described in Signing In or Signing Out. More detailed
remarks can be inserted in the Additional Information screen.

Also see

Signing In

Signing Out

Maintaining The List of Remarks



Maintaining the List of Remarks

The list of remarks is the list from which users may select a remark. To modify this list, choose Modify
Remarks List in the Options menu. A window containing the list of remarks will appear. This list may
be updated using the three buttons that appear (Add, Remove, and Close). To add a remark to the list,
click on Add and type a remark. To remove a remark from the list, select the remark to be deleted and
click on Remove. To close the pop-up window, click on Close.

Remarks can have a “smart” field which prints the current time. To add a remark with the current time,
insert the word “time” in uppercase or lowercase within {} brackets. For instance, type “Left at {current
time} “. The current time will be printed in the remark when the users choose it.

A second type of field is the prompt field which requests the user to add information. To add a prompt to
a remark, insert the prompt text within <> brackets. For example, include <date> to prompt the userto
enter a date. The user can add as many smart fields as they need.

If the master list of remarks becomes modified extensively and you want to reset it to the original set of
remarks provided by this program, choose File and Load Standard Remarks.



Sending Messages

To send a message, click on the name of the person to whom you wish to send a message. From the
pop-up menu, select Send Message. This action opens a dialogue box. All the standard Windows
editing features are available.

If you want to send the same message to another person, press the copy button to place the entire
message text into the windows clipboard. There is no need to select text as is often the case when
placing text into the clipboard. You can use the paste button to retrieve the clipboard text and place it
into the message area.

Similarily, the paste button can be used to transfer text from other applications, saving you from having to
retype data that exists in other documents.

If a phone message is to be sent, press on Phone Msg and type replies to the prompts for the name and
number. Press Send to send the message and exit or press Cancel to delete the message and exit.

Also see
Reading Messages



Reading Messages

A blue flashing background on your name indicates a new message has been received. To read your
message: (1) do CTR R; or (2) click on your name and, from the pop-up menu, select Read Message.
This opens a dialogue box which displays a message as well as the date and time it was sent and the
author. The header on the screen indicates the number of total and new messages the user has received.

Options available on the screen are: Copy to Clipboard, Print, Reply, Erase, Erase All, Next, and
Close. Copy to Clipboard copies the text of your message to the Windows clipboard, thus making it
available to be pasted into your favourite word processor. Messages which have not been read are
coloured green for the first viewing. They will be coloured black for any subsequent viewings. Upon
exiting the window, the background on your name will no longer flash.

Messages are confidential. You cannot read another user's messages from your own workstation.

Note: When the program is installed, the name of the user must be identified with his/her workstation so
that the user can receive messages at that workstation. To do this, click on the name to be associated
with that workstation and select My Name from the pop-up menu. The name will appear in the top title
bar. This procedure need never be repeated, unless a new user operates at that computer. The My
Name command is password protected. See Password Access.

Also see
Notification of Message Received



Notification of Message Received

If a new message is received when OfficeView is hidden by another program window or is in an icon
state, it will pop-up in its normal size in front of all other windows. The background of your name will
flash and the Title Bar will blink “MESSAGE”. If you do not want to read the message at that time, then
press the space bar to minimize OfficeView. If you choose to minimize OfficeView without reading your
message, the text on the icon will blink “MESSAGE” to remind you that a new message was received.
When you want to read it, click on Options/Read Message (or short-cut Ctl R).

See also
Reading Messages



Updating the Employee Information Window
You can change the information in your Employee Information window, provided your name appears in
the top title bar. (If your name does not appear in the title bar, then refer to Administration (paragraph

on associating names with workstations)).

To update the information in the window, click on your name and Information and make the changes.
Althought this screen can be viewed by all users, only the employee or the Administrator can update it.

The standard Windows editing features are available in this very large Notepad.

A messages flag will indicate if the user has unread mail.

There is a miscellaneous field to record your choice of information, e.g., home phone number, person to
contact in your absence, hours of work, station/building.



Hiding the Yellow Pop-Up Help Hints

To prevent the yellow pop-up help hints from appearing, choose Yellow Hints under Options. The
absence of a tick mark in front of this item indicates that the hints are turned off. Clicking on Yellow
Hints toggles this feature on and off.



Hiding the Name Warning

The question, "This is not your name. Do you want to proceed?" appears when a user chooses a name
other than his/her name. To turn off this warning, choose Name Warning under Options. The absence

of a tick mark in front of this item indicates that the question is turned off. Clicking on Name Warning
toggles this feature on and off.



Enlarging or Reducing the OfficeView Screen

The OfficeView screen may be enlarged or reduced in steps of 60%. The screen can be blown up so
that it is visible from a distance. To resize the screen, click on Options/Shrink Screen or
Options/Expand Screen. You may find it more convenient to use F4 to shrink or F5 to expand.



Using Group OfficeView
(Included in program for 300 or 1000 nhames)

Searching for a Name

Type in the first few letters of the name. As you type, the cursor will automatically scroll to the name in a
pop-up screen containing an alphabetical list of names. This list contains all names in the organization
(not limited to the employee's group).

Displaying a Group

To display an organizational group, select Group and the name of the group to display.

The following commands are password protected. Refer to Password Access.

1) Adding a Group
To add the name of an organization/group, choose File/Add New Group. A window will appear
indicating "Enter New Group Name". Type in the name and click OK.

2) Adding User Names to a Group

The group must be chosen before adding new users. You must be viewing the group; that is, the name
of the group should appear in the top title bar. The commands for adding users to groups operates the
same as outlined in Adding New Names.

3) Renaming a Group

To rename an organizational group’s title, select the name of the group to be modified by clicking on
Group and the name of the group. This name will appear in the top bar of the screen.  Choose File/
Rename Group. A window will appear indicating "Enter New Name". Type in the name and click on
OK.

4) Deleting a Group

To delete a group and erase all the names in that group, select the name of the group to be modified by
clicking on Group and the name of the group. This name should appear on the top bar of the screen.
Then choose File/ Delete Group. A window will appear asking to confirm that the group should be
deleted. Click on Yes.

Also see
Password Access
Administration
Admin Mode
User Mode



Searching for a Name
(Included in program for 300 or 1000 names)

This feature provides a fast method to locate a name. Type in the first few letters of the name. As the
name is typed, an alphabetical list of names will pop-up on the screen and the cursor will be automatically

scrolled to the name with matching letters. Type Enter to switch to the group containing the name that is
highlighted. This feature will search all names in the organization.



File Menu
The file menu includes the following commands:

a) Load Standard Remarks

This command allows you to overwrite the existing remarks with a set of standard default remarks.  You
may use this feature when the list of remarks has been modified and you wish to return to a standard set
of remarks.

b) Set DB Path
This command is primarily intended to allow OfficeView that is residing on a local hard drive to access a
server database. This configuration reduces the LAN traffic and makes the program run faster.

Choose this command to set the directory path of the main database used by a program operating at a
single workstation. Programs running at other workstations are not affected. It is possible to have some
workstations running from the local hard drive and some from the shared directory.

You should use the setup program to initially place the necessary files in the new directory before
attempting to use this command. The Set DB Path command will do validity checks to ensure that the
new path possesses the necessary access rights and contains the proper files. Any failure to meet the
validity checks will result in a message indicating the problem, such as “Database files missing. New
path rejected.” or “File creation failure. New path rejected.”

Another circumstance when the Administrator may wish to use this command is when making a major
change to the database. This can be done in a new directory without affecting the users. Once the new
database is ready, the users can be switched over to it.

It is possible for each database to have a different admin password. To avoid confusion, the best policy
is to ensure that you use the same admin password on all your databases.

c) Admin Mode
This enables the user to change the configuration, i.e., add names, delete names, etc.. Initially, the
Admin Mode password is set to 'abc'.

d) Change Password
This enables the user to change the password to access Admin Mode. You will be asked to enter the
current password once and your new password twice. Initially, the security password is set to 'abc'.

e) User Mode
This disables commands that allow users to change the configurations, i.e., add names, delete name,
etc..

f) Add Name
Click on Add Name and type the name to be added. Press Enter or OK to enter the name or press
Cancel to cancel the command. This command is password protected. See Password Access.

g) Add New Group (300 and 1000 names only)

This command is password protected. Refer to Admin Mode above. Choose this command to add a
group. A window will appear with the prompt "Enter New Group Name". Type in the name and click on
OK.

h) Rename Group (300 and 1000 names only)

This command is password protected. Refer to Admin Mode above. To rename the title of a group,
select the name of the group to be modified by clicking on Group and choosing the name of the group.
This group name should appear on the top bar of the screen. Then choose File/ Rename Group. A



window will appear indicating "Enter New Name". Type in the name and click on OK.

i) Delete Group (300 and 1000 names only)

This command is password protected. Refer to Admin Mode above. To delete a group and erase all the
names in that group, select the name of the group to be deleted by clicking on Group and selecting the
name of the group. This name should appear on the top bar of the screen. Then choose File/ Delete
Group. A window will appear asking to confirm that the group should be deleted. Click on Yes.

j) Exit

Quits OfficeView

See also
Using Group OfficeView



Group Menu

To view a group, choose Group in the menu bar.  Alist of organizational/group names will appear.
Choose the desired group. The screen will display the names in that group and the title bar will indicate
the group name.



Options Menu
This menu contains the following commands:

a) Read Message

Select to read your messages. Note: In order for users to be able to read their messages, the program
must identify a name(s) with workstations. To do this, click on the name to be associated with that
workstation and select My Name from the pop-up menu. The name will appear in the top title bar. This
procedure need never be repeated, unless a new user operates at that computer. The My Name
command is password protected. See Password Access.

b) Modify Remarks List

Click on Modify Remarks List to display the list of remarks. To add a new remark to the list, click on Add
and type a remark into the field displayed in the dialog box that pops up. To remove a remark from the
list, highlight the remark to be deleted and click on Remove. After making the modifications, click on
Close to save the changes and exit the window.

c) Shrink Window
Click on this to reduce the window to your preferred size.

d) Expand Window
Click on this to expand the window to your preferred size.

e) Yellow Hints
Click on this command to toggle the feature on and off. When a tick mark appears on this menu item,
then the yellow pop-up hints are activated.

f) Name Warning
Click on this command to toggle the feature on and off. When a tick mark appears with this menu item,
then the pop-up question window is activated.

g) Sign Out on Exit
Click on this command to toggle the feature on and off. When a tick mark appears with this menu item,
the program will automatically change your status from IN to OUT whenever you turn off your computer.

h) Change Others'

Click on this command to toggle the feature on and off. When a tick mark appears with this menu item,
the program will allow you to change remarks for any name. Otherwise, you can only change your own
remark. This command is password protected.

i) New Message Sound
Click on this command to toggle on and off the sound notification that a new message has arrived. When
a tick mark appears with this menu item, then the sound is "on".



Help Menu

a) Contents
Click on Contents to launch the on-line help system.

b) Topic Search
Click on Topic Search to search for on-line help for a subject.

c) About
Select this item to display a window containing buttons for registration and ordering information. It also
contains program information (e.g., registration and serial numbers).



ADMINISTRATION

Password Security

OfficeView has a security system (password) to control access to use the following commands: Add
Name, Remove Name, My Name, Change Password, Add New Group, Rename Group and Delete
Group and to control access to make changes to the Employee Information screens for all employees. To
allow access to make these changes, the Administrator(s) need only click on File/Admin Mode and enter
a password. To return to the normal mode of operation, click on File/User Mode.

Note: The unregistered versions of OfficeView start up in Admin mode so that all commands are easily
available for evaluation.

To change the admin password (initially="abc"), click on File/Change Password and enter the current
password once, and the new password twice. The program will confirm that a new password has been
accepted. Passwords must consist of letters only.

Adding Groups, Names, and information in the Employee Information screen:

When you add groups, names and update the Employee Information screen while other users are
operating OfficeView, it may take a few minutes before the new information appears.

To add new groups (300/1000 name version only), switch to Admin mode by clicking on File/Admin
Mode. Enter the password (initially="abc"). Type Ctrl+G and the name of the group. The new name
will appear in the Group menu.

To populate the board with user names, switch to Admin mode by clicking on File/Admin Mode. Enter
the password (initially="abc"). Type Ctrl+N and the name.

You can enter information into the Employee Information screen by clicking on the name and selecting
Information. Employees may prefer to enter this information for themselves after you identify their name
at their own workstation.

Identifying Names with Workstations

The program must identify names with workstations so that users can read their messages and make
changes to the Employee Information screen at their workstations. To do this, after a new name is
added, change to Admin Mode by selecting File/Admin Mode at the workstation. Next, click on the name
to be associated with that workstation and select My Name from the pop-up menu. The name will appear
in the top title bar, indicating that the association of that user with that workstation was successful. Also,
if you wish to prohibit the user at that workstation from making changes to another user's remarks, click
on Options/Change Others'. The tick mark in front of Change Others' will turn off, indicating the user
at that workstation cannot change others' remarks. OfficeView will remember your settings.

Also see:
User Mode
Admin Mode

Change Password

Adding New Users

Associating a Name With a Workstation
Removing Users

Using Group OfficeView



INSTALLATION AND REMOVAL

Disk Space Requirements

The common network directory should have four megs of free disk space. This allows for over three
megabytes of spare room to hold messages. For the client workstations, you will need two kilobytes of
disk space if you are running on a dedicated Server. Otherwise, 500 kilobytes of disk space will be
required on the workstations to store local copies of the program files.

Installing OfficeView

If you receive OfficeView in a compressed format, i.e., from the Internet or a CD library, you will receive all
the OfficeView files as a single file. If the file name ends in ".exe", it is a self-extracting program that will
decompress the files and run the Setup program automatically. If the file name ends in ".zip.", you will
require a program to decompress the files, e.g., WinZip. Both ".exe" and ".zip" filenames are available
from our website: http://www.capitalnet.com/~phillips/

If you are installing the program on more than one workstation, then one copy of the program and
database files must be installed on the shared directory. This directory can be located on a Server or
shared on a peer-to-peer LAN, such as Microsoft Networks or Lantastic. Installing on a Server is
preferable, if possible. All users should be given read, write and create privileges in the shared directory.

Installing the Files on the Server:

First, install the OfficeView files on the common network directory. From any workstation, click on the File
menu of your Windows Program Manager, and select Run (Windows 95 uses Start/Run). Type the
name of the compressed OfficeView file or the appropriate Setup program (setup.exe for 16-bit or
setup32.exe for 32-bit) and click OK. For the self-extracting program, click the Setup button. Select
Network Install, then Server, and follow the screen instructions. The OfficeView Setup program installs
within seconds.

Next, run OfficeView and add all the groups and their associated employee names before setting up any
other workstations.

Running OfficeView from the Server:
(not recommended for peer networks)

Running OfficeView from your server allows all workstations to run from a single copy of the main
program.

At each workstation, assign (map) a drive letter to the common network directory and be sure to enable
the option to automatically reconnect when Windows starts up. From the common network directory, run
the Setup program to set up the workstations. Select Network Install, then Workstation. \When
prompted for the directory location, enter the workstation path to the common network directory.

Running OfficeView from a Local Hard Drive
(for peer networks or congested LANSs):

At each workstation, assign (map) a drive letter to the common network directory and be sure to enable
the option to automatically reconnect when Windows starts up. From the common network directory, run
the Setup program to set up the client workstations. Select Single Install. When prompted for the "Copy
to" directory, accept the default of C:\OView. At this point, the workstation is working in isolation. To
enable communication with other users, OfficeView needs the location of the common OfficeView
database. To do this, run OfficeView using the newly created Program Manager group (Windows 96/NT



4.0 use Start/Programs/OfficeView menu) and click File/Set DB Path. Enter the workstation path to the
common network directory. At this stage, any names in the central database will display. As an additional
test, send a message to another user and confirm that it arrives.

Running OfficeView Standalone:

To run OfficeView on a single workstation, click on the File menu of your Windows Program Manager, and
select Run (Windows 95 uses Start/Run). Type the name of the compressed OfficeView file or the
appropriate Setup program (setup.exe for 16-bit or setup32.exe for 32-bit) and click OK. For the self-
extracting program, click the Setup button. Select Single Install and accept the suggested "copy to"
directory. This procedure creates a Program group or Windows 96/NT 4.0 Start/Programs/OfficeView
menu that can be used to run OfficeView.

Note:
Both the 16- and 32-bit versions of OfficeView are designed to run concurrently using the same
database. Therefore, in a mixed operating system environment, 32-bit workstations aren't required to

use 16-bit software.

If you are upgrading OfficeView from the 10/30 names size to the 300/1000 names size or from 16-
bits to 32-bits, you must re-run the Setup program at each client workstation.

Finally, follow the procedures in Administration to add names/groups.
Un-installing OfficeView:

The following steps outline how to completely remove the main copy of OfficeView (do all steps) and the
LAN Workstations copies (do first two steps only):

| Delete the OfficeView group and OfficeView icon from the Program Manager.
| Delete ovlocal.ini from the main windows directory (usually c:\windows).

| Delete all files in the OfficeView directory ( default directory c:\OView ).

| Delete the OfficeView directory.

Questions:

If you have any questions, send them to phillips@capitalnet.com or officeview@ottawa.com. In addition,
the OfficeView web site at "www.capitalnet.com/~phillips" has a support page to assist you.



FEEDBACK AND UPGRADES

We welcome any suggestions you have for improvements or upgrades or other information you may wish
to communicate about this product. Your comments will be considered in preparing any future upgrades.
You may contact the author via e-mail at phillips@capitalnet.com or officeview@ottawa.com.

We are providing a five-name version of OfficeView for 10 or 30 users and a three-user in three groups
version for the 300 or 1000 user programs free of charge. To increase the number of users, you must
register your copy of OfficeView by purchasing the package, as outlined on the Order Form.

For the latest version, check our Internet Home Page at http://www.capitalnet.com/~phillips/.



Credit Card Orders

You can order with MC, Visa, Amex, or Discover from Public (Software) Library by:

- calling 1-800-242-4775 Extension 15051 or 1-713-524-6394 Extension 15051; or

- faxing the order form, including this page, to 713-524-6398; or

- CIS e-mail to 71355,470@compuserve.com ; or

mailing credit card orders to PsL at P.O. Box 35705, Houston, TX 77235-5705; or

- using the link at http://www.capitalnet.com/~phillips/ to access the Internet World Wide Web secure
transaction ordering service.

If you mail or fax, be sure to type or print plainly and be sure to ask for product number 15051.

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY. THE AUTHOR OF THIS
PROGRAM (LEN PHILLIPS) CANNOT BE REACHED AT THESE NUMBERS.

Any question about the status of the shipment of the order, refunds, registration options, product details,
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc., must be
directed to Len Phillips at phillips@capitalnet.com or via the internet web site support page at
http://www.capitalnet.com/~phillips/

Name:

(first/middle) (last)
SHIP-TO ADDRESS

Company name:

Address:

City:

State/Province:

Zip/Postal Code:

Country:

Your e-mail address:

CREDIT CARD INFORMATION

Credit card start:

Expiration month:

Expiration year:

Complete any of the following which is different from the above:

Name on the card:




CREDIT CARD BILLING ADDRESS

Company name:

Address:

City:

State/Province:

Zip/Postal Code:

Country:




O RD E R F 0 RM (use File, Topic Print to get a hard copy)

Payment by check or money order (payable to Len Phillips) and purchase orders may be sent directly to Len Phillips.
Payment by credit card or by third party on-line secure web transaction is made via Public Software Library (PsL),
Texas. To make payment by credit card, refer to credit card orders.

Purchase orders (net 30 days) are accepted only from government, accredited educational institutions and major
corporations, provided they are submitted on purchase order forms with a purchase order number.

Please mail this form with your payment or purchase order addressed to Len Phillips, 915 Plante Drive, Ottawa,
Ontario, CANADA K1V 9E3. You may e-mail phillips@capitalnet.com for a fax number.

When you purchase this product, you will receive a diskette containing program files. In case you do not want to
wait to receive the mailed version, in addition, we will e-mail a registered version to you.

OfficeView is shipped on 3.5 inch disks only.

Size Price Net
10 Name (16-bit) $30.00 US

10 Name (32-bit) $30.00 US

30 Name (16-bit) $50.00 US

30 Name (32-bit) $50.00 US

300 Name (16-bit) $99.00 US

300 Name (32-bit) $99.00 US

1000 Name (16-bit) $199.00 US

1000 Name (32-bit) $199.00 US

Ontario residents add 7% prov. sales tax
Canadian residents add 8% GST
Shipping & handling add $5.00 ( U.S.) $5.00

Total Payment

Name:

Company:

Address:

City: State/Province:
Zip/Postal Code: Country:
Phone No.: Fax No.:
E-Mail Address: P. O. No.:
Comments:

V210 Feb2 1997



OfficeView - an elecltronic in/out board



LEGAL DISCLAIMER

While every effort has been made to make this document as accurate and helpful as possible, Len
Phillips makes no warranty of any kind with regard to its content. All information included herein is
subject to change without notice. Len Phillips and any associates are not responsible for any loss or
damages, direct or indirect, arising from or related to the use of this product.

All rights reserved. Reproduction, adaptation or translation without prior written permission is prohibited,
except as allowed under copyright laws.






